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Intfroduction

Indenting text adds structure to your document by
allowing you to separate information. Whether you'd
ike to move a single line or an entire paragraph, you
can use the tab selector and the horizontal ruler 1o

set tabs and indents.




Indenting text

In many types of documents, you may want to indent only the
first line of each paragraph. This helps to visually separate
paragraphs from one another.
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| am exceedingly interested in the Junior Marketing positi
and | believe that my education and employment background are

While working toward my degree, | was employed as a mat
grocery company. In addition to assisting the company with their ;
to help the Marketing Specialist develop and carry through ideas 1
commercial. | would like to use the knowledge | gained at Fresh F¢
achieve its marketing goals, including reaching a broader audienc¢

It's /also possible to indent every line except for the first line,
wihich is known as a hanging indent.
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Worles Cited

Twain, Mark. Mark Twain at the Buffalo Express: Articles and Sketch

- Humorist, edited by Joseph B. McCullough and Janice McInti

Northern Illinois University Press, 20007.




Indent using Tab key

quick way to indent is to use the Tab key. This will create a first-
line indent of 1/2 inch.

Plaoce the inserfion point at the very beginning of the
paragraph you want 1o indent.

2. Press the Tab key. On the Ruler, you should see the first-line
indeniyarker move to the right by 1/2 inch.
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|I am exceedingly interested in the Junior Marketing position w§
believe that my education and employment background are w¢

While working toward my degree, | was employed as a market
company. In addition to assisting the company with their sum
the Marketing Specialist develop and carry through ideas for th
would like to use the knowledge | gained at Fresh Foods to helf
marketing goals, including reaching a broader audience across
degree in marketing in May and will be available for employme




Indent using Tab key

The first line of the paragraph will be indented.
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Indent markers

®» [N some cases, you may want fo

have more control over indents.
Word provides indent markers that
allow you to indent paragraphs to
the location you want.

. » The indent markers are located to the

left of the horizontal ruler, and they
provide several indentfing options:

% First-line indent marker “/ adjusts the
first-line indent

% Hanging indent marker - adjusts the
hanging indent

% Left indent marker & moves both the
first-line indent and hanging indent
markers at the same fime (this will
indent all lines in a paragraph)



Indent with indent markers

. Place the insertion point anywhere in the paragraph you want
to indent, or select one or more paragraphs.
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EXPERIENCE

Executive Assistant Il cHICAGO, IL

Rev Development Group, June 2007 — Present

Supported the Vice President and Chief Human Resources
Officer. Developed new hire orientation for administrative staff,
and delivered to 25 new employees to date. Maintained
company website. Saved over 53,000 annually by implementing
new travel and per diem system.

Office Manager SPRINGFIELD, IL

Carter Taylor Investments, October 2001 — June 2007
Managed all administrative responsibilities for staff of 100+.
Pioneered the use of CRM database software (Salesforce) for
tracking business contacts and managing financial advisors’
schedules.

Administrative Assistant SPRINGFIELD, IL

Icon Office Solutions, May 1997 — ( Calibri (Body) - Jdx on o« As"
Supported the Operations Manage &
two Service Managers. Answered: B J U 3~ - A v i— v := - Styles
for six phone lines. Processed Mon iy cureo e oo

average billing cycle of $350,000+.




Indent with indent markers

. Click and drag the desired indent marker. In our example, we'll
click and drag the left indent marker.
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EXPERIENCE
Executive Assistant Il cHICAGO, IL

Rev Development Group, June 2007 — Present

Supported the Vice President and Chief Human Resources
Officer. Developed new hire orientation for
administrative staff, and delivered to 25 new employees
to date. Maintained company website. Saved over $3,000
annually by implementing new travel and per diem
system.

Office Manager SPRINGFIELD, IL

Carter Taylor Investments, October 2001 — June 2007
Managed all administrative responsibilities for staff of
100+. Pioneered the use of CRM database software
(Salesforce) for tracking business contacts and
managing financial advisors’ schedules.

Administrative Assistant SPRINGFIELD, IL

Icon Office Solutions, May 1997 — October 2001
Supported the Operations Manager, Branch Manager,
and two Service Managers. Answered and directed
incoming calls for six phone lines. Processed monthly
sales bills for an average billing cycle of $350,000+.




Indent with indent markers

. Release the mouse. The paragraphs will be indented.
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EXPERIENCE
Executive Assistant Il CHICAGO, IL
Rev Development Group, June 2007 — Present
Supported the Vice President and Chief Human Resources
Officer. Developed new hire orientation for
administrative staff, and delivered to 25 new employees
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to date. Maintained company website. Saved over $3,000
annually by implementing new travel and per diem
system.

Office Manager SPRINGFIELD, IL

Carter Taylor Investments, October 2001 — June 2007
Managed all administrative responsibilities for staff of
100+. Pioneered the use of CRM database software
(Salesforce) for tracking business contacts and
managing financial advisors’ schedules.

Administrative Assistant SPRINGFIELD, IL

Icon Office Solutions, May 1997 — October 2001
Supported the Operations Manager, Branch Manager,
and two Service Managers. Answered and directed
incoming calls for six phone lines. Processed monthly
sales bills for an average billing cycle of 5350,000+.|




Indent using indent commands

lf you want o indent multiple lines of text or all lines of @
aragraph, you can use the Indent commands. The Indent
ommands will adjust the indent by 1/2-inch increments.

Select the text you want to indent.

2. On the Home tab, click the Increase Indent or Decrease Indent
command.

3. The text will indent.
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Indent using indent commands

To customize the indent amounts, select the Layout tab
near the desired values in the boxes under Indent.
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Talbs

Using tabs gives you more control over the placement of text. By
default, every tfime you press the Tab key, the insertion point will
move 1/2 inch to the right. Adding tab stops to the Ruler allows
you to change the size of the tabs, and Word even allows you
to apply more than one tab stop to a single line. For example,
on a resume you could left-align the beginning of a line
and right-align the end of the line by adding a Right Tab, as
shown/;he image below.

wnonn
O

1 Gl 2 3 4 5

TRAINING & EDUCATION
Microsoft Office Specialist MICROSOFT OFFICE 2010
Microsoft Certification 2008

Bachelor of Arts BUSINESS ADMINISTRATION
University of lllinois at Springfield 1997 — 2001

Associate’s Degree OFFICE ADMINISTRATION
Lincoln Land Community College 1995 — 1997




The tab selector

The tab selector is located above the vertical ruler on the left.
Hover the mouse over the tab selector to see the name of the
active tab stop.
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Types of tab stops

The tab selector is located above the vertical ruler on the left.
Hover the mouse over the tab selector to see the name of the
active tab stop.

* Left Tab v left-aligns the text at the tab stop.

* Center Tab + centers the text around the tab stop.
* RightTab - right-aligns the text at the tab stop.
* DecimalTab * aligns decimal numbers using the decimal point.

* BarTab ' draws avertical line on the document.

* First Line Indent “ inserts the indent marker on the Ruler and indents the

first line of text in a paragraph.

* Hanging Indent © inserts the hangingindent marker and indents all lines

other than the first line.

=\ Alfhough Bar Tab, First Line Indent, and Hanging Indent appear
the tab selector, they're not technically tabs.




Adding tab stops

1. Select the paragraph or paragraphs you want to add tab stops
to. If you don't select any paragraphs, the tab stops will apply
to the current paragraph and any new paragraphs you type
below it.
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' Administrative Assistant SPRINGFIELD, IL
Lotus Notes Icon Office Soluti May 1997 — October 2001
’ Adobe InDesign con Office Solutions, . ay ctober
© Adobe Photosh Supported the Operations Manager, Branch Manager, :
' Obe Fhotoshop and two Service Managers. Answered and directed |
incoming calls for six phone lines. Processed monthly i
sales bills for an average billing cycle of $350,000+.

7 TRAINING & EDUCATION
- Microsoft Office Specialist MICROSOFT OFFICE 2010
Microsoft Certification 2008

Bachelor of Arts BUSINESS ADMINISTRATION :
University of lllinois at Springfield 1997 — 2001

Associate’s Degree OFFICE ADMINISTRATION

N Lincoln Land Community College 1995 — 1997 .




Adding tab stops

Click the tab selector until the tab stop you want to use
appears. In our example, we'll select Right Tab.
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Adding tab stops

Click the location on the horizontal ruler where you want your
text to appear (it helps to click on the bottom edge of the
Ruler). You can add as many tab stops as you want.

4. Place the insertion point in front of the text you want to tab,
then press the Tab key. The text will jump to the next tab stop. In
our example, we will:move each date range to the tab stop
we cregted.

TRAINING & EDUCATION
Microsoft Office Specialist MICROSOFT OFFICE 2010
Microsoft Certification 2008
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ELD. 1L 1 Universty of Winois at Springfield

Associate’s Degree OFFICE ADMINISIRATION.

Lincoln Land Community Collegg \1995 —-1997




Removing tab stops

It's a good idea to remove any tab stops you aren't using so
they don't get in the way. To remove a tab stop, first select all of
the text that uses the tab stop. Then click and drag it off of the

Ruler.
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Removing tab stops

Word can also display hidden formatting symbols such as spaces ( - ), paragraph
marks (T), and tabs (=) to help you see the formatting in your document. To show
hidden formatting symbols, select the Home tab, then click the Show/Hide
command.
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Practice (Part 1)

Open our practice document.

Use the Tab key to indent the beginning of each
paragraph in the body of the cover letter. These start
with | am exceedingly interested, While working
toward, and Enclosed is a copy.




Solution

April 13, 2016

Ms. Ella Jackson

Human Resources Manager
1234 Modern Street Drive
Trenton, NJ 08601

Dear Ms. Jackson:

I am exceedingly interested in the Junior Marketing position with Top Tier Telephones,
and | believe that my education and employment background are well suited for the position.

While working toward my degree, | was employed as a marketing assistant with a local
grocery company. In addition to assisting the company with their summer promotions, | was able
to help the Marketing Specialist develop and carry through ideas for the company’s next
commercial. | would like to use the knowledge | gained at Fresh Foods to help your company
achieve its marketing goals, including reaching a broader audience across country. | will
complete my degree in marketing in May and will be available for employment in early June.

Enclosed is a copy of my resume, which more fully details my qualifications for the
position. Within the next week, | will contact you to confirm that you received my email and
resume and I'll be happy to answer any questions that you may have. Thank you for your
consideration.

Sincerely,

Adrienne Patel




Practice (Part 2)

Scroll fo page 2.

Select all of the text below Training & Education on
page 2.

» Place aright tab at the 6" (15.25 cm) mark.
® |nsert your cursor before each date range, then press

the Tdb key. These dates include 2008, 1997-2001,
and/1995-1997.

Sefect each job description under the Experience
sgction and move the Left Indent to the 0.25" (50 mm)
ark.




Solution

ADDRESS 415 Bishop Street #303 CELL  312.555.6840

Chicago, IL 60608 EMAIL addie.patel@gmail.com
ADRIENNE PATEL
SUMMARY EXPERIENCE
Tech-savvy, Executive Assistant Il cHicaco, IL
solutions-oriented Rev Development Group, June 2007 — Present
professional with Supported the Vice President and Chief Human Resources
experience in all Officer. Developed new hire orientation for administrative
aspects of office staff, and delivered to 25 new employees to date.
management, Maintained company website. Saved over 53,000 annually
administration, and by implementing new travel and per diem system.

support.

Office Manager sPRINGFIELD, IL
SKILLS Carter Taylor Investments, October 2001 — June 2007
Managed all administrative responsibilities for staff of

Wind &M
[naows ac 100+. Pioneered the use of CRM database software

Microsoft Office . ) .

Aople iWork (Salesforce) for tracking business contacts and managing
PP i financial advisors’ schedules.

SharePoint

Salesforce Administrative Assistant

QuickBooks ministrative Assistant SPRINGFIELD, IL

Icon Office Solutions, May 1997 — October 2001
Supported the Operations Manager, Branch Manager,
and two Service Managers. Answered and directed

Lotus Notes
Adobe InDesign

Adobe Photoshop incoming calls for six phone lines. Processed monthly

sales bills for an average billing cycle of $350,000+.

TRAINING & EDUCATION
Microsoft Office Specialist MICROSOFT OFFICE 2010
Microsoft Certification 2008

Bachelor of Arts BUSINESS ADMINISTRATION
University of lllinois at Springfield 1997 — 2001

Associate’s Degree OFFICE ADMINISTRATION
Lincoln Land Community College 1995 — 1997




TAE END




